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1  Introduction 

The EGN ArcGIS Extension provides access to the EuroGeoNames (EGN) Gazetteer service 
from within ESRI ArcGIS Desktop. The EGN ArcGIS Extension performs name searches 
based on several query criteria from within ArcMap and allows users to analyze, visualize, 
and save results in a standard GIS software environment. The extension’s graphical user inter-
face language is English. 

This document refers to version 1.0.0.0 of the EGN ArcGIS Extension which is submitted as 
deliverable 8.1. This version works with the prototype version of the EGN Central Service at 
Geodan. After the installation of the EGN Central Service at its final location, a new updated 
version of the EGN ArcGIS Extension will be made available. 

2 Installation and requirements 

The EGN ArcGIS Extension can be installed on any Windows Computer which has ArcGIS 
Desktop version 9.2 or later installed. No other ArcGIS Desktop extensions are required. The 
EGN ArcGIS Extension is open source and no licensing is required to use it. The source code 
as well as the installation package will be made available at http://arcscripts.esri.com (search 
for “EGN ArcGIS Extension”) as soon as the EGN Central Service is at its final location. 

The installation package for the extension ships as Microsoft Windows Installer (.msi). To 
install, just double click the install file (EGN_ArcGIS_Extension_Setup_x.x.x.x.msi) and fol-
low the instructions provided by the installation wizard as shown in Figure 1. 

 
Figure 1: Installation wizard 

 

Once the wizard has completed, it is recommended that you restart your system. Afterwards, 
start ArcMap and activate the EGN ArcGIS Extension via the ArcMap Main Menu toolbar: 

Tools > Extensions 

Then add the “EGN ArcGIS Extension Toolbar” via: 

View > Toolbars 

The EGN ArcGIS Extension Toolbar” consists of one button which starts the  EuroGeoNames 
Extension for ArcGIS window. To search for a name using the EGN Gazetteer service, enter a 
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search term and then click the Find button. Note: An internet connection is required to per-
form searches . 

3 User interface 

The EGN Extension consists of a single ArcMap window which is subdivided into three sec-
tions (see Figure 2):  

- In the top section, the search term and the maximum number of listed results can be 
specified.  

- The middle section supports the construction of complex queries. Constraints can be 
applied to the search term itself (e.g. using wildcards with the exact search type), to the 
attributes of the features (e.g. only populated areas), and spatial filters can also be ap-
plied to reduce the geographic area being searched.  

- The lower section of the window shows query results. On the left, a list of all found 
features is displayed. On the right, detailed attributes for a single, selected found fea-
ture are shown.  

Results of any search are strongly conditioned by the data quality and completeness provided 
by the EGN services. The EGN ArcGIS Extension is only an interface facilitating the use of 
the EGN Central Service. 

 
Figure 2: EGN Extension window in ArcMap 
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4 Performing name searches 

4.1 Performing simple name searches 

After opening the EGN Extension window you can immediately send search requests to the 
EGN service. Just enter a search term and click Find.  

Although requests made using the default search parameters often return satisfactory results, 
you can define more complex search requests using the techniques described in the following 
sections. 

4.2 Searching specific feature attributes 

To specify a request that will only return features with specific attribute values, use the De-
sired feature attributes tree-list. Here you can choose the feature attribute values which will 
be considered valid for the query. Only features with these values will be listed in the search 
results. For example, Figure 3 shows a request which only returned features classified as 
countries, administrative units or other non-administrative units. All other feature types (e.g. 
Populated places) were ignored in the query. 
 

 
Figure 3: Request only desired feature attributes 

4.3 Searching with fuzzy, exact, or “sounds like” l ogic 

The extension allows you to define how exactly names will searched for your search term.  

- fuzzy: Finds names containing the search term, while automatically applying wild-
cards. For example, a search for the term “Berlin” will return all names containing 
“Berlin” anywhere in the name. The fuzzy method is implemented by adding the mul-
tiple wildcard character at both ends of the search term (e.g. *Berlin*).  
 

- exact: Finds names containing the exact search term. For example, a search for the 
term “Berlin” will return only the names which are exactly “Berlin”. Also, to “fuzzify” 
the search logic, you can manually add the following wildcard characters to your 
search term: 
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o multiple (“ * “) 
o single (“ # “)  
o escape (“ ! “)  

- sounds like: Finds similar names using the Soundex algorithm. To change the Soundex 
algorithm, see Section 8.2. 

 

  
Figure 4: Search type check boxes options in the EGN extension 

4.4 Definining search options for multi-word search  terms 

The extension allows you to choose how a multi-word search term (e.g. “Frankfurt am Main”) 
will be treated in a search. There are three options: 

- all words: Finds names that contain all words from the search term. For example, a 
search for “Frankfurt am Main” would only return features containing all three words 
in their name: “Frankfurt”, “am”, and “Main”. 

- any word: Finds names that contain any word from the search term. For example, a 
search for “Frankfurt am Main” would return any feature containing any of the three 
words in its name. 

- exact term: Finds names that exactly match the search term. 
 

 
Figure 5: Multi-word search options in the EGN extension 

4.5 Specifying a locale 

To apply particular locale settings when peforming queries, change the Language and Country 
under Locale settings. Figure 6 shows an example where the results list has been reduced from 
four down to two features by changing the Country to “Latvia (lv)”. Setting a specific locale 
can often help return wanted features more quickly. 

 

 
Figure 6: Geographic searching options 
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4.6 Searching within a geographic extent 

Choose the spatial filter option Current extent to restrict a search to the current ArcMap map 
extent. 

5 Common EGN Extension search scenarios  

The preceding sections provided several search examples which were possible, but not logical 
to use often in a real-world situation. This section describes some common, realistic search 
scenarios using the EGN extension. 

5.1 EGN Extension search scenario: Searching with S earch type = fuzzy 

Follow these steps using the EGN Extension in ArcMap: 

1. Enter “Frankfurt am Main” as the Search term.  

2. Choose fuzzy for the Search type. 

3. Choose all words for method used to handle multi-word search terms.  

4. Click Find. 

Three features are returned (Figure 7), each containing all the words “Frankfurt”, “am” and 
“Main”. In this case the request is built by connecting together the search term words with the 
logical operator AND. 

 
Figure 7: Searching for all words in the EGN extension 

 

5. Choose the any word option. This option connects together the search term words with 
the logical expression OR. 

6. Click Find. 

Many more features are returned by this search (Figure 8). First, a feature need only contain 
one of the search term words (“Frankfurt” or “am” or “Main”). Secondly, the automatic 
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addtion of wildcards (resulting from the choice of fuzzy) further increases the number of re-
turned features.   

 
Figure 8: Searching for any word in the term. 

 
7. Choose the exact term option. This option does not connect the search terms words by 

any logical operator, rather is searches for an exact match for all words in the exact or-
der. 

8. Click Find. 

The same number of features are returned by this search as with the any word option. 

 

 
Figure 9: Searching for the exact term. 
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5.2 EGN Extension search scenario: Using the exact search type with wild-
cards 

With this search type the request will only contain wildcards that have been specified manu-
ally by the user. Follow these steps using the EGN Extension in ArcMap: 

1. Enter “Frankfurt am Main” as the Search term.  

2. Choose exact for the Search type. 

3. Choose all words for method used to handle multi-word search terms.  

4. Click Find. 

No features are returned by this seach (see Figure 10). As seen before, an all words request is 
built using the AND operator, and because of the exact search type (without specifying some 
wildcards manually) our request looks for a feature being “Frankfurt” <AND> ”am” <AND> 
”Main” at the same time. So this kind of request works well only for single words as search 
term. 

 
Figure 10: Exact search type combined with the all words method. 

 

5. Choose the any word option. This option connects together the search term words with 
the logical expression OR. 

6. Click Find. 

This search returns a completely different result. In this case the service is asked to return fea-
tures containing any words of the entered search term “Frankfurt am Main”. But, since there 
are also no wildcards (from the choice of exact), only the results: “Main” and “Frankfurt” are 
returned (Figure 11).  
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Figure 11: Exact search type to any word  of the search term. 

 

Combining the exact search type with the exact term method allows us to specify in a more 
appropriate way what we are searching for. For example, if you enter “Frankfurt” as the search 
termm, without the use of any wildcards, only one feature would be returned “Frankfurt”. 

7. Choose the exact term option. This option does not connect the search terms words by 
any logical operator, rather it searches for an exact match for all words in the exact or-
der. 

8. Enter “*Frankfurt” as the Search term.  The * is the multiple wildcard character. 

9. Click Find. 

This search will return all features ending with “Frankfurt” (see Figure 12). 

 
Figure 12: Exact search for exact term using the * wildcard. 

 

10. Enter “Frank##” as the Search term.  The # is the single wild card character, it repre-
sents exactly one arbitrary character in the search term. 

11. Click Find. 
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This search will result in features all beginning with the five characters “Frank” and followed 
by any two other characters. 

12. Enter “*Frank##” as the Search term. 

13. Click Find. 

This search will additionally get also those features that can have any characters at the begin-
ning of their name (Figure 13). 

 
Figure 13: Exact search with combination of wildcards. 
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6 Viewing results 

The lower part of the EGN Extension window allows you to view the results. On the left side 
(Figure 14) the Result tab contains a table showing the returned features, and also provides 
“right click” access to additional functions based on the selected feature. 
 

  
Figure 14: Result Tab with table of result features (left) and attribute details of selected result (right) 

 
The detailed feature attributes list at the bottom right side of the extension window shows the 
full attribute information for the selected feature in the Result tab. Additional functions “right 
click” functions are also available for a selected attribute. 

Also on the left side, the Request tab displays the last XML request sent to the service, and the 
Response tab displays what was returned. 

 
Figure 15: XML view of a request 

6.1 Organizing results 

The following functions are available to organize the contents in the Results table: 

- Drag-and-drop a column header to change the column position of an attribute. 
- Click a column header to sort results list by that attribute.  
- The Results table shows a default list of attributes. To add an attribute as a new col-

umn, right click an attribute in the detailed attributes list (Figure 16) and choose Show 
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in results table. Note: not all attributes must have values, depending on the type, accu-
racy and precision of the data available from the EGN services. 

- To remove an attribute from the Results table, right click an attribute in the detailed at-
tributes list (Figure 16) and choose Hide from results table. 

 

 
Figure 16: Add attribute to results table 

 

6.2 Viewing hierarchical relationships between feat ures 

When data are available which describe hierarchical relationships between features (i.e. par-
ent-child associates between higher order and lower order features), EGN Extension window 
shows this information in the following attributes: 

- AllParents 
- FirstParent 
- AllChilds 
- FirstChild 

For example, the Latvian city of Griga�ciems shows V� rves pagasts as its sole parent feature 
(see Figure 17). 

 
Figure 17: Hierarchical (parent) information  

 

6.3 Searching for alternative identifiers 

The EGN Extension supports name searches which consider endonyms and exonyms. To en-
able this feature, right-click on a feature in the Result list and choose Search for alternative 
identifiers. Doing this populates the attributes Alternatives (which shows a count of the num-
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ber of alternative identifiers for a feature) and AlternativeGeographicIdentifer (which lists its 
alternative identifiers) . Although many features have no alternatives identifiers, the German 
exonym 'Riga' has three. (Figure 18). Note that searching for alterative identifers makes a new 
request to the EGN Central Service and thus will create a new Result list. 

 
Figure 18: Searching for alternative identifiers 

 
To replace the Result list with only the alternative identifiers, right click on the Alterna-
tiveGeographicIndentifier list on the right and choose Search for this identifier  

 
Figure 19: Updating the Results list with alternative geographic identifiers 
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7 Visualizing results 

EGN Extension search results can be visualized in ArcMap. Simply right click on any feature 
in the Result list (see Figure 20) to locate, navigate to, bookmark, and map any found feature 
directly in your ArcMap Data Frame. Visualized results can also be saved in an ArcMap Map 
Document file (.mxd). 

 
Figure 20: Options and tools to manage result features 

 
To correctly visualize features, your currently opened ArcMap document must have a coordi-
nate system specified. By default ArcMap sets the data frame coordinate system based on the 
coordinate system of the first dataset that has been loaded to the data frame.  

7.1 Locating and navigating to features 

The following location and navigation tools are available by right clicking on a found feature: 

- Flash temporarily highlights the feature on the map.  
- Zoom To zooms the map view to the feature.  
- Pan To centers the map view on the feature.  

7.2 Saving and retrieving feature locations 

Two extension tools are provided which allow you to save a geographic extent for a found 
feature (see Figure 21).  

- Create Bookmark creates an ArcMap Bookmark. You can return to a Bookmark via 
the ArcMap Main Menu Toolbar > Bookmarks.  

- Add to my Places… Creates a entry in the ArcMap My Places list. You can return to a 
My Places entry via the ArcMap Main Menu Toolbar > Tools > My Places. 
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Figure 21: Saving and retrieving feature locations within ArcMap 

 

 

7.3 Mapping and storing features 

7.3.1 Tools for mapping and storing features 
 
The EGN Extension provides two powerful tools which allow you to map feature results:  
 

- Add Graphic creates a map graphic for the feature. 
- Add Labeled Graphic creates a map graphic and text label for the feature. 
 

Furthermore, ArcMap allows you to convert map graphics to features. Do this using the Con-
vert Graphics to Features tool which is accessed via the Draw toolbar > Drawing (see Figure 
22). Use this tool to store query results from the EGN service as new features on your local 
computer. 
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Figure 22: Convert map graphics to features with the ArcMap Draw toolbar 

7.3.2 Feature mapping limitations due to heterogene ous results 
Due to differences in available data, different features returned from the EGN service may 
provide different types of geometry, even if the features are the same type. In some cases, even 
if a feature (e.g. an administrative unit) should have an areal extent, a data provider may not 
allow to access to the entire geometry for that feature. In this situation, the Add Graphic tool 
will draw the point centroid instead of the polygon outline. An example data limitation is 
shown in Figure 23. The EGN service provides polygon outlines for Berlin and Frankfurt am 
Main, while in contrast, only point geometry is returned for Amsterdam. Similar examples can 
also be found with line features. 

 
Figure 23: Feature mapping limitations 
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8 Configuring the extension 

The EGN Extension is configured by a single file: ”egn.esri.arcgis.dll.config” which is found 
at the local machine’s EGN extension installation location. This location is defined during the 
installation process (e.g. “C:\Program Files\ArcGIS\EGN ArcGIS Extension\”).  

Several parameters in this file can be changed, such as the URI of the EGN Central Service. 
Note: configuration parameters should be changed only by experienced users. Also note that 
changes to the configuration file affect all users of the EGN Extension on the same computer. 

8.1 Changing EGN Central Service connection paramet ers 

If the URI of the EGN Central Service should change, change the value of the “WFSServer” 
setting in the configuration file (see Figure 24).  

 
Figure 24: Connection Parameters 

8.2 Changing the Sounds Like algorithm 

The EGN Central Service supports four Sounds Like functions: 

- soundex (extension default) 

- metaphone 

- dmetaphone 

- dmetaphone_alt.  

To change the extension’s Sounds Like algorithm, change the two configuration file settings: 
“SoundsLikeProperty” and “SoundsLikeFunction” (see Figure 25) 

 
Figure 25: Sounds Like Parameters 
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9 Technical Overview 

This section briefly describes the implementation details of the EGN ArcGIS Extension. For a 
more complete overview, please also refer to the Concept and Requirements document for the 
EGN ArcGIS Extension [1]. 

The EGN ArcGIS Extension is a free, downloadable extension to ArcGIS Desktop which is, 
compatible with ArcGIS versions 9.2 and later. After the end of pilot testing, the extension 
will be available for download from ESRI ArcScripts (http://arcscripts.esri.com/).  Both 
source code and binaries will be available. Any interested person is free to create and release a 
newer version of the extension. 

9.1 Dependencies with the EGN Central Service 

The EGN Extension for ArcGIS is a client application of the EGN Central Service. The EGN 
Central Service is the extension’s only external source of information. All search requests sent 
from the Extension go through the Central Service (see Figure 26). 

 
Figure 26: EGN Web Service Architecture [3] 

 
At the end of the project the prototype of the EGN Central Service, ( see WP 6 – EGN web 
services infrastructure) was available at http://egn.geodan.nl/egn-central-
service/services?SERVICE=WFS&VERSION=1.1.0&REQUEST=GetCapabilities (GetCapa-
bilities request). The submitted version (v1.0.0.0 as in D8.1) of the EGN ArcGIS Extension is 
based on this version of the Central Service. Changes to the Central Service or its relocation to 
the final service provider will require a new version of the Extension. 
 
The EGN Central Service is implemented as WFS 1.1.0 service. This WFS Protocol supports 
these requests: 

- “GetCapabilities” which returns feature type information (as well as other information) 
- “DescribeFeatureType” which returns the structure of a specific feature type 
- “GetFeature” which returns specific feature instances from the server. 

 
The EGN ArcGIS Extension uses only the “GetFeature” request. It assumes that the input and 
output schemes, as well as the “GetCapabilities” and the “DescribeFeatureType” responses, 
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are static. EGN Central Service changes which alter the results of these two requests (e.g. 
changes to the data model) would very likely also require changes in the EGN Extension for 
ArcGIS. 

9.2 Extending ArcGIS Desktop 

Developers can create new custom extensions to ArcGIS Desktop by working with Ar-
cObjects, the ArcGIS software component library. Thereby standard Windows programming 
interfaces such as the .NET Framework with Visual Basic or C# and Visual C++ can be used. 

ArcObjects itself is a set of platform-independent software components that provides services 
to support geographic information system (GIS) applications on the desktop in the form of 
thick and thin clients and on the server. Many ArcObjects components are used the ArcGIS 
Desktop products as well as in ArcGIS Server. 

As an ArcGIS Desktop extension, the EGN ArcGIS Extension extends the core functionality 
of the ArcGIS with additional functionality. Extensions typically provide a user interface and 
can be created for all ArcGIS Desktop applications (e.g. ArcMap, ArcCatalog). 

ArcObjects provides the IExtension and the IExtensionConfig interface (see Figure 27) for 
implementing the extension. In the application logic, the state of the extension (enabled, dis-
abled, unavailable) can be checked to initialize and activate the user-interface. 

 
Figure 27: IExtension and IExtensionConfig Interfaces [2] 

 

More information about extending ArcGIS can be found in the ESRI Developer Network and 
in the Developer Resources [2]. 

  
Figure 28: Configuring ArcMap Extensions 
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After an extension is installed and registered, it is visible in the Extensions dialog box of the 
ArcGIS application (e.g. ArcMap) (see Figure 28). This window, often referred to as the Ex-
tension Manager, contains all the visible extensions for that application. The extension can be 
switched enabled or disabled within this dialog box. 

 
Figure 29: EGN Extension Toolbar 

 

The EGN ArcGIS Extension has its own toolbar (see Figure 29) which can be activated at 
“View > Toolbars”. Clicking the EGN Extension button on the Toolbar opens the EGN Ar-
cGIS Extension Client. 

9.3 Developing the EGN ArcGIS Extension in Microsof t Visual Studio 

The extension was developed in Microsoft Visual Studio 2005 (see Figure 30) using the .NET 
framework and C# as programming language. The sources of the extension provided at 
http://arcscripts.esri.com will ship together with the Visual Studio Solution and Project files. 

 
Figure 30: EGN ArcGIS Extension in Microsoft Visual Studio 

 

The Visual Studio Solution “EGN_ArcGIS_Extension” consists of the two projects 
“EGN_ArcGIS_Extension” (see §9.4), which contains the extension itself, and 
“EGN_ArcGIS_Extension_Setup” (see §9.5), which creates the installer for the extension. 
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9.4 EGN ArcGIS Extension Project 

The project “EGN_ArcGIS_Extension” contains at the main level the following important 
subfolders and class files: 

- \egntools: this folder contains helper classes e.g. for visualizing search results on the 
map or for managing the extension settings. 

- \egnrequest: this folder contains the class files for creating a WFS request to the EGN 
Central Service (for more details see §9.4.1). 

- \egnxml: this folder contains the class files for parsing the WFS response from the 
EGN Central Service (for more details see §9.4.2). 

- \help: this folder contains the HTML source files for the Help documentation. 

- EGNApplicationExtension.cs: this is the extension class which implements the IEx-
tension interface and thus makes the EGN ArcGIS Extension available in ArcMap. 

- EGNToolbar.cs: this is the toolbar which contains the EGNCommand button 

- EGNCommand.cs: this command lauches the EGN ArcGIS Extension by opening the 
EGNClient form if the user clicks the button on the EGNToolbar. 

- EGNClient.cs: this class is the central class of the EGN ArcGIS Extension. It defines 
the user interface and it contains the functions to search for names and to display the 
names on the map currently opened in ArcMap. Some important functions in this class 
are for example: 

o CreateRequest(): this function creates the XML WFS request for the Central 
Service. It uses the helper classes in \egnrequest (see also §9.4.1). 

o SendRequest(): this function sends the XML WFS request to the Central Ser-
vice via HTTP. 

o ReadResponse(): this function receives the response of the Central Service. 

o ParseWFSGetFeatureResponse(): this function parses the XML WFS re-
sponse using the helper classes in \egnxml (see also §9.4.2). Each individual 
name result is stored in a LocationInstanceNameFeature. 

o flashToolStripMenuItem_Click(object sender, EventArgs e): this function 
highlights the location of the currently selected name result on a map. All func-
tions that visualize results in ArcMap use the currently active map. The coordi-
nates of the name location are automatically converted for the spatial reference 
of the currently active map. 

o … 

- EGNAboutBox.cs: this form displays the information about the extension including 
the version and the provider of the extension. 

- WebbrowserForm.cs: this Webbrowser form is used to display the XML requests and 
results to advanced users. 

- LocationInstanceNameFeatureBindingList.cs: this class implments the Sortable-
BindingList.cs and is used for displaying the single search results (LocationInstance-
NameFeature.cs) in the results table. 
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The settings of the project “EGN_ArcGIS_Extension” are used to define important parameters 
for the extension (see Figure 31). These settings are stored in an XML file with the extension 
and are read while starting the extension. This allows advanced users to make changes to the 
extension whithout having to change the code (see §8). These settings contain also the proper-
ties for creating the WFS Request to the Central Service (see §9.4.2). Properties like the URI 
of the Central Service can easily be accessed in the code using the DynamicAssemblySettings 
class from the \egntools folder. 

 
Figure 31: Settings of the EGN ArcGIS Extension Project 

9.4.1 Creating a WFS Request 
We can assume that the capabilities and feature type description of the EGN services don’t 
change frequently. The data model of the EGN service is defined in work package WP4. The 
definition of the EGN feature type (LocationInstanceName) used for the EGN service relies to 
the data model is well defined. 

To accelerate the behavior and usage of the extension, the main parts of the capabilities and 
feature type description are stored in property files of the extension. The GetCapabilities and 
DescribeFeatureType requests can be omitted and the GetFeature request and response are 
based on the pre-defined information of the extension which is defined in the settings of the 
EGN ArcGIS Extension Project  (see Figure 31). 

The Central Service is implemented as a Web Feature Service (WFS). Searching the Central 
Service therefore requires sending a request (wfs:Query) with filter operations (ogc:Filter). 
For more information please refer to [3]. The filter operations may include for example spatial 
and/or comparison filter-operations for searching specific feature instances of a region or in-
cluding a specific text. 
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A basic request searching for all entries of “Berlin” therefore needs only one PropertyIsLike 
filter which searches for “Berlin” in the Name element of the EGN Data Model (Property-
Name “egn:name/egn:PT_FreeText/egn:plainText ”): 

<?xml  version =" 1.0 "  encoding =" utf-8 " ?> 
<wfs:GetFeature  xmlns:xsi =" http://www.w3.org/2001/XMLSchema-instance "   
xmlns:xsd =" http://www.w3.org/2001/XMLSchema "  xmlns:gml =" http://www.opengis.net/gml "  
xmlns:ogc =" http://www.opengis.net/ogc "  xmlns:egn =" http://www.eurogeonames.eu/egn "  
version =" 1.1.0 "  xmlns:wfs =" http://www.opengis.net/wfs " > 
  < wfs:Query  typeName =" egn:LocationInstanceName " > 
    < ogc:Filter > 
      < ogc:PropertyIsLike  wildCard =" * "  singleChar =" #"  escape =" ! "  matchCase =" false " > 
        < ogc:PropertyName >egn:name/egn:PT_FreeText/egn:plainText </ ogc:PropertyName > 
        < ogc:Literal >Berlin </ ogc:Literal > 
      </ ogc:PropertyIsLike > 
    </ ogc:Filter > 
  </ wfs:Query > 
</ wfs:GetFeature > 

In the \egnrequest folder of  the project “EGN_ArcGIS_Extension” all required filter opera-
tions are implemented as a .NET class schema. These classes can directly be serialized into 
XML for sending a request to the Central Service. Thus the RequestBuilder instanciates the 
request simply from the class schema and can then just be serialized into XML. 

Filter operations are PropertyIsEqualTo, PropertyIsLike and Bbox (Bounding Box for spatial 
searches). These filter operations can be combined using the logical operators And as well as 
Or. This allows nesting and combining of different filter operations. See the class diagram in 
Figure 32) 

 
Figure 32: Request Builder Class Diagram 

… 

9.4.2 Parsing the WFS Response 
The XML WFS response of the Central Service has to be parsed and made available as search 
results in the EGN ArcGIS Extension Client. The development was again driven by the as-
sumption that the capabilities and feature type description of the EGN services don’t change 
frequently. Thus the data schema of the response of  the GetFeature request has been imple-
mented as .NET classes such that the XML response can be deserialized into it. The XML re-
sponse contains a WFS FeatureCollection. Each featureMember in this collection represents a 
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LocationInstanceName feature which is represented in the .NET schema by the class EgnLo-
cationInstanceName (see class diagram in Figure 33). 

 
Figure 33: Response Parser Class Diagram 

 

The LocationInstanceName feature contains the properties like the Name of the result. The 
LocationInstance property contains for example the Position of the feature which is encoded 
as GML point in the WFS response. 

The parsing of the response is done by the ParseWFSGetFeatureResponse() function in the 
extension main class EGNClient. After the successful deserialization of the XML response the 
instanciated WFS response is converted and saved as LocationInstanceNameFeature objects in 
the results table (using the LocationInstanceNameFeatureBindingList) of the EGNClient. 

9.5 EGN ArcGIS Extension Setup Project 

The project “EGN_ArcGIS_Extension_Setup” allows the fast creation of a .msi setup routine. 
The resulting .msi setup routine installs the EGN ArcGIS Extension files and registers them in 
order to make them available for ArcMap. 

After having finished the development  in the project “EGN_ArcGIS_Extension”. Rebuild it 
such that the most recent changes are in the binary release. Open the Windows Explorer, navi-
gate to the “EGN_ArcGIS_Extension” project folder. Copy all files from \bin\Release to the 
folder \currentBuild in the “EGN_ArcGIS_Extension_Setup” project folder by replacing exist-
ing files. Now build the “EGN_ArcGIS_Extension_Setup” project. The new .msi file can be 
found in the \Release folder. 
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